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What Is Eclipse?

● Eclipse is an Open Source Community
– Open source means all code is shared by all 

community members
● Projects focus on an “Extensible 

Development Platform” and “Application 
Framework”
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What Is Eclipse? (continued)

● The Eclipse Product is Visual Based IDE 
Development Tool
– Think of Microsoft's Visual Studio
– Instead of developing C++ applications, it is used 

to develop Java applications
– Full featured IDE with a GUI Interface

● Eclipse was written with Eclipse !!
– Eclipse is an Eclipse based application
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Notes Was Written With Eclipse

● The Notes 8 and 8.5 Standard Clients were 
written using Eclipse
– They follow the Eclipse standards
– They allow developers to extend the functionality 

through plug-ins
● What's a plug-in?

– Hold on for a minute...
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Java Runtime Environment

● JRE 1.6 is the version installed with the 
Notes 8.5 client
– Notes installs its own JRE instead of using the 

operating system version
● Too many compatibility potential issues right now

● See tech note 1188789 for the supported 
versions of Java with other IBM products
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Plug-ins

● From a programming standpoint a plug-in is 
a collection of
– Java Classes that define forms, views, 

perspectives
● Creating objects, what to do when things happen, etc

– Graphics and icons
– HTML files
– Configuration Files
– A Manifest
– Other Necessary files
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Plug-ins (continued)

● Plug-ins allow a product to expand its 
functionality

● You may be familiar with the term from a 
browser perspective
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Plug-ins (continued)

● Plug-ins modify the host application in such 
a way that menus, main screens, and 
options can contain new items related to the 
plug-in
– Can add/enhance menus
– Can add/enhance tool bar buttons
– A plug-in can have its own user interface
– Can even modify the host user interface
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Plug-ins And Notes Standard

● The Notes Standard client has many, many 
plug-ins

● Each plug-in is responsible for a specific 
piece
– One plug-in for one specific task, not one plug-in 

for several tasks
● Means there are many plug-ins, each handling a 

specific task



12

Plug-in File Structure

● Plug-ins named in “reverse order” of release 
date, number, function, owner
– For example...

● The Eclipse core comes from the “www.eclipse.org” 
web site, so core eclipse files will have names like 
org.eclipse.equinox.registry_3.4.0.v20080516-0950.jar

– Registry program release 3.4.0
– Released May 16, 2008 at 9:50 AM
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Plug-in File Structure (continued)
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Eclipse Framework

● Does every eclipse based product install its 
own Eclipse framework?
– Currently Notes, Integrated Sametime, Symphony 

(Productivity Editors) and Activities can be 
combined into one install and share a framework

– Some Eclipse based applications will install their 
own framework (ISA tool, stand-alone Sametime) 

● The installers of this or Notes will not detect the 
previous framework and utilize it at the current time

– The ability to have a single framework install for all 
necessary applications is being investigated



Basic Client
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Notes 8.5 Basic Client

● Your first tool for troubleshooting 8.5 client 
issues is the Notes 8.5 Basic client
– If you haven't begun the deployment yet, it might 

be a good idea to install two icons on the user's 
Windows desktop

● One for the Standard Client and one for Basic
● What is the Basic client?

– Launches Notes without the Eclipse/Java 
environment

– Resembles Pre 8 Notes Client
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Notes 8.5 Basic Client (continued)

● Why is this a useful tool for troubleshooting?
– Can help in troubleshooting by determining if an 

issue is reproducible without the Eclipse 
framework

– Support will usually ask if the issue is reproducible 
in the basic client as one of the first questions

– Testing this prior to opening a PMR and including 
results can assist in expediting the PMR
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Notes 8.5 Basic Client (continued)



Demo Time!
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Demo Time!

● We're going to do a quick demonstration
– Launching Notes Standard
– Launching Notes Basic



Debug Parameters
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Useful Debug Parameters

● console_loglevel=2
● client_clock=1
● debug_outfile=
● logfile_dir=
● logStatusBar=1

● debug_threadID=1
● enable_break=1
● debug_console=1
● debug_busy=30



23

console_loglevel

● console_loglevel=2
– Old console_log_enabled parameter

● This parameter is no longer necessary
– Default console log level
– Parameter is present in INI file by default

● Enabled by default
– Do not need to change unless instructed to do so 

by support



24

client_clock

● client_clock =1
– Information about how long notes takes to 

perform different functions and WHAT function
● Information about what functions notes is performing 

(opening a database, opening a document, 
authenticating, building a view, etc)

– Parameter available prior to Notes 8
– When enabled, information will appear in the 

console log along with normal console messages
– Other values (besides 1) not recommended 

unless requested by support
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debug_outfile

● debug_outfile=<full path>
– Default location for console log is 

<notes data>\IBM_TECHNICAL_SUPPORT
– This parameter changes the default location
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logfile_dir

● logfile_dir=<full path>
– Changes default location for ALL log files

● Naming convention for log files
– console.log is the current log
– console_name_yyyy_mm_dd@hh_mm_ss.log is 

the log for the session that ended at that date/time
– New console log created at each startup
– Old log files are not automatically cleaned up
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logStatusBar

● logStatusBar=1
– Records status bar messages to a log buffer
– Any message that appears in the status bar also 

appears in the console log
● Appears with “Status Msg:” in front of the message
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debug_threadID

● debug_threadID=1
– When a log message is generated, includes the 

thread that triggered the message
– Useful when troubleshooting client crashes

● Associate the thread that caused the crash with log 
messages from the same thread

– Appears in the console log before the date/time
● [0FB8:0002-0FBC] mm/dd/yyyy 09:07:35 AM  

Dynamic Client Configuration shutdown
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enable_break

● enable_break=1
– When set and using OSGi console, allows user to 

generate a Java core if a problem occurs
● What is the OSGi console?

– We'll get to that in a few slides
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debug_console

● debug_console=1
– Displays a live Notes console
– Shows information that is also written to the 

console log
– Useful when waiting for something to happen

● Once you see it recreated in the Notes console, 
capture the appropriate dump information
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debug_busy=30

● The parameter value is a “number of 
seconds”

● If any user initiated action exceeds this 
number, then a call stack will be output
– There are some actions where the response from 

the server might take a while, like a search
● After the 1st stack, a stack will be output at 

2X, 4X and 8X in case the wait continues
● Output from this setting is not necessarily a 

bug
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Additional Log Files

● Notes Client Log Files
– Still available in IBM_TECHNICAL_SUPPORT 

directory
– Includes the Console Log
– logfile_dir allows these files to be written to a 

different location then the default
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Additional Log Files (continued)

● Eclipse Log Files
– Located by default in
<notes data>\workspace\logs

– Trace logs
● Information also shown in Eclipse console

– Error logs
● Installation Log Files

– Location will vary



Demo Time!
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Demo Time!

● Time for another demonstration
– Viewing log files
– Adding debug to notes.ini file



NSD Commands
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NSD

● If anyone in your company is still using an 
old third party product (like killnotes) to 
terminate Notes processes, discontinue
– You should be using NSD instead
– You can change the shortcut of the icon to run an 

NSD instead of the third party product
● NSD is used to terminate Notes and all its 

processes and optionally generate a system 
dump for diagnostic purposes
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NSD Options

● NSD -kill
– Stops all Notes Process and Generates an NSD
– For some issues, the NSD may not be helpful, but 

the command will still ensure all Notes Processes 
are stopped.

● NSD -dumpandkill
– Creates a dump file (if available) in addition to the 

NSD and kills all of the Notes Client related 
processes



Eclipse Console
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Eclipse Console

● Earlier, slides mentioned the “OSGi” console
● This is the Eclipse console
● Allows viewing of live information that also 

will be logged into Eclipse log files
– Generally, information that is specific to Eclipse
– There might be some duplication with the Notes 

console, but not very much
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Eclipse Console (continued)

● You can now launch Standard Notes with 0, 
1, or 2 additional console windows
– Notes console

● Enabled via debug_console=1 in the notes.ini file
– Eclipse console

● Enabled via modification to the shortcut used to launch 
Notes

● See next slide
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Enabling Eclipse Console

● The -RPARAMS option is 
used to send commands 
to Eclipse

● -Console command will 
launch the Eclipse 
Console with Notes

● Add enable_break=1 to ini
– Allows Java core generation 

if problem occurs
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Example Eclipse Console
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Important: Eclipse Console

● It is VERY IMPORTANT that you DO NOT 
close the Eclipse/OSGi Console manually
– Let the shut down of the Notes client close the 

console
– If the Notes client will not shut down, run an NSD 

to force the console to close
– If you close the console with Notes running, you 

may not be able to do anything more in Notes
● You might force yourself into HAVING to run an NSD
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What Console Should I Use?

● Client Clock, Notes Console, and Console 
Log will only be helpful with Notes Issues

● If Eclipse is not starting up correctly, Notes 
Console, Client Clock and Console Log may 
not have any information in them
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-RPARAMS

● -Console is not the only -RPARAMS option
● -RPARAMS -Clean

– Cleans the Eclipse workspace subdirectory
● Removes cached information, state information
● Less intrusive compared to removing entire subdir

– Use this option as a “first attempt” when 
troubleshooting Eclipse-specific startup issues

● Do not use excessively
– Notes uses this temporary information to improve 

performance of the client
– Only use for issues instead of deleting workspace directory
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-RPARAMS (continued)
● -RPARAMS -resetconfig

– Deletes the Eclipse workspace subdirectory
– Use if the -Clean option does not work
– Not Recommended but has been found to resolve 

some issues
– If Clean does not work, further troubleshooting will 

not help, and Eclipse still will not start
– Workspace subdirectory can be manually deleted, 

but -resetconfig is much easier
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-RPARAMS (continued)

● -RPARAMS -resetconfig (continued)
– Will remove user preferences and settings that 

are stored in Eclipse
– New Workspace Directory is built from the 

Framework folder in the Notes Client Programs 
Directory

● All of the default settings taken from the files stored 
there

– Some policy based settings may not be applied
● Depends on where the preferences are stored
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-RPARAMS (continued)

● -RPARAMS -resetconfig (continued)
– WARNING: Desktop policies are only reapplied 

when they are changed
– If the Personal names.nsf does not indicate that 

the policy has changed, it may not be reapplied, 
so in addition to losing custom settings for the 
user, company based policy settings also may not 
be applied when removing the workspace 
directory



Demo Time!
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Demo Time!

● We're going to do another demonstration
– Launching Notes Standard with Notes 

Console
– Launching Notes Standard with OSGi 

Console
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Break Time

● Time for a 30 minute break



Preferences
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Preferences

● Basic and Standard Client May Not keep 
some preferences in the same location

● As Development of the Notes Client 
progresses, the standard client will migrate 
towards keeping preferences in the 
<notes data>\workspace\.metadata 
folder

● This will increase the number of settings 
stored in different locations
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Preferences (continued)

● See tech note 1283416 for a list of where 
certain preferences are stored
– Tech note written for Notes 8, but most are still 

applicable to Notes 8.5
– This is just to give an idea of how different 

preferences are stored in different locations



Tips And Tricks
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Troubleshooting Red X Emails

● Tech note 1110585
● Check if standard browser can access the 

Internet
– Firefox, IE, etc.
– If user can't access Internet, Notes can't either
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Red X Emails (continued)

● Is the image embedded or attached?
– Look in Document Properties for $File
– If attached ($File is there), look at tech notes 

1108466, 1109097, and 1196889
● Internet Messages Arrive with Attachments or Body 

Parts That Appear Missing or Are Inaccessible
● Notes client does not render an attachment for users 

with 'No Preference'/'Keep in Sender's Format' as mail 
storage preference

● Users are not automatically prompted to 'Retrieve 
Internet service certificate' when images in HTML do 
not display
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Red X Emails (continued)

● Is the image embedded or attached?
– If embedded ($File is not there), follow these 

steps:
● Set the Location Document to use Notes as the default 

browser and enter the same URL to the image location
– Sometimes, perweb.nsf was never activated and this 

should activate it
– In other cases, perweb.nsf doesn't exist and needs to be 

created
● If entering the URL fails, see if there is a proxy set in 

IE and/or Notes and if they are the same
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Cleaning Bookmarks

● Instead of deleting bookmark.nsf, try to 
clean the bookmark database
– Less invasive to the user
– Many settings/options will be retained

● They are lost if bookmark.nsf is deleted
● Use this as a “first try” and only delete if all 

else fails
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Cleaning Bookmarks (continued)

● Process
– From Notes Client Desktop
– Ctrl+Shift and Right Click on Bookmarks Icon
– Select Application -> Go Too
– Select View “By URL” (No $ Sign)
– Select All Documents in this View (Ctrl+A)
– Delete the Documents

● May Generate “Object Variable …” Error
– This is OK, it is a not a view we should be in
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Cleaning Cache

● Process can be repeated for cache.ndk
– File -> Application -> Openn n
– Manually type cache.ndk for filename
– Esc to close “About Page”
– Ctrl+Shift and Select View Gotoo
– Same Procedure as Bookmarks

● Cache.ndk does not contain very many user 
specific settings or preferences so it is also 
acceptable to delete
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Cleaning Bookmark/Cache

● After cleaning either bookmark.nsf or 
cache.ndk, restart the Notes client
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Desktop Icon Issues

● When the desktop icons are not acting 
correctly the following steps may help:
– Compact Desktop / Workspace

● Right Click on Workspace in GUI
● Workspace Properties
● Click on the Beanie Tab
● Click on the Compact Button

– Can also manually compact with Notes Client 
down

● ncompact desktop8.ndk
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Desktop Icon Issues (continued)

● Other things to try when desktop icons are 
misbehaving:
– Unstack icons, remove outdated references, stack 

icons
● Sometimes the unstack/stack refreshes cached info

– Look for icons referencing old servers
● Remove those icons from the workspace

– Check the cluster.ncf file for old references
● File can be viewed with Notepad/Wordpad
● Can be deleted; it will be recreated automatically
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Compact Notes Data Directory

● Upgrading Notes Clients does not perform a 
compact or upgrade the ODS of existing 
data files

● After several releases, data files may need 
to be compacted to reduce fragmentation or 
upgrade to a newer ODS

● With Notes Client down
– ncompact -c -i 
– Enter client ID's Password when prompted
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Other Hints/Tips

● Check template versions 
of names.nsf, 
bookmark.nsf and other 
local system files

● Replace design if 
necessary
– Might have to show 

advanced templates when 
replacing designs
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Other Hints/Tips (continued)

● User complaining about poor performance
– Check Windows hard drive fragmentation
– Check for anti-virus scanning Notes files

● Discover with Filemon
– Check for unwanted interaction from other 

products
– Check swap file size

● Recommend setting it to 1.5 amount of installed RAM
– If 32-bit... but do not go higher than 4GB
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Other Hints/Tips (continued)

● How is the user shutting down Notes/OS?
– Client crash from OS shut down displayed false 

positive crash reports in fault recovery database
● OS is shut down while Lotus Notes is opened
● OS does not contain an application timeout to force 

the OS shutdown
● Notes2 or similar process would get the rug pulled 

from underneath itself
– The good: Crash is cosmetic to user, happens randomly
– The bad: consistency check upon next launch



IBM Support Assistant
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IBM Support Assistant (ISA)

● IBM Support Assistant is a complimentary 
software offering which provides you with a 
workbench to help you with problem 
determination

● A “lite” version is installed with Notes 8.5.x
● A “full” version (called the workbench) is 

available for download
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ISA (continued)

● ISA can be used to...
– Gather troubleshooting information to send in to 

IBM or your help desk
– Search public tech notes and other resources for 

possible causes/solutions
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ISA (continued)

● Launching ISA prior to 8.5.2
– Help -> Support -> IBM Support Assistant

● Dialog box appears for search, collecting data, etc.
● Launching ISA in 8.5.2

– Help -> Support -> Collect Support Data
● Data collection piece is automatically launched

● Launching ISA from outside of Notes
– Go to <Notes program>\framework\rcp
– Run startcollector.bat (startcollector.sh in Linux)
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Collecting Data

● The ISA collector gathers all problem 
determination data into a .zip file and 
informs the user of the location of the file
– Files in the .zip use the OS file structure

● <notes data>\workspace\logs
● <notes data>\IBM_TECHNICAL_SUPPORT
● And so on
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ISA Search Tips

● Use 1-2 keywords with “Standard Client” and 
Notes in Search (especially if issue is not 
reproducible in basic client)

● Use “” when 2 words need to be together
● Try to describe feature that is misbehaving 

with proper name of the feature 
– For example “Message Recall” not “Get Mail 

Back”
– Help documents can assist in identifying the 

proper name of the feature
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ISA Search Tips (continued)

● If a tech note issue is similar but not exactly 
(and is applicable to your release) attempt to 
recreate the issue described in the tech 
note... it may still be related
– If you can recreate the issue in the tech note that 

is similar, you might be able to reference that tech 
note when talking to IBM

– You might also be able to get a work around by 
using information from the tech note



Demo Time!
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Lab Time!

● We're going to do another demonstration
– Discovering a bug in the 8.5.1 client
– Collecting the ISA data



Types Of Issues
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What Types of Issues are There?

● Different types of issues have different 
debug, different troubleshooting steps, and 
potentially different information support may 
need to collect

● Categorize the 4 Major Types of Issues
– Crash
– Hang
– Non Fatal Error
– Slow Performance
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Notes Client Crash

● Attributes of a “Crash”
– Used to be a “Red Screen”
– Now Shows Java Exception Error
– Should generate NSD by default
– If ADC is on, should mail in NSD by default
– Can not recover from crash.
– Usually requires user to stop all Notes processes, 

then restart client.
– Any other slow behavior or error which allows 

user ability to move on, is not considered a crash
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Notes Client Hang

● Notes doing some task and doesn't respond
● Pressing CTRL+BREAK will not stop the 

task and return control
● Eventually need to restart client, but the 

client didn’t stop on its own
● Usually no Pop-up error message or fatal 

screen like with a crash
● No ‘red screen’ or java equivalent
● Usually will not have an automatic NSD
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Non-Fatal Error

● Usually associated with a dialog box
– Click OK (or similar) in the dialog box, move on
– Control is returned to the client after clicking OK in 

the dialog box
● May not be able to complete original task, 

but can move on to other tasks with no 
issues
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Slow Performance

● Similar to a hang, but Notes eventually 
returns control to the user

● May need to CTRL+BREAK after some time 
in order to return control



Troubleshooting Steps
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Notes Client Crash

● Can the crash be reproduced?
● Does the crash happen in both Standard 

and Basic?
● Was an NSD generated to help assist?
● Look at console logs for error messages
● Adding client_clock to the notes.ini may 

assist in determining what action was being 
performed at the time of the crash
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Notes Client Hang

● Can the hang be reproduced?
● Does it happen in both Basic and Standard?
● Add debug parameters to assist

– debug_threadID=1
– client_clock=1
– debug_busy=30

● 30 is the number of seconds
● If any user-initiated action exceeds this number, then a 

call stack will be initiated
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Notes Client Hang (continued)

● Use NSD -dumpandkill to collect information
– Then use ISA to gather up all the information

● Use console logs to see what Notes was 
doing at the time of the hang
– Also use console logs to see if it really is a hang 

and not slow performance
– If it is truly a hang, no more messages will be 

written to the consoles
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Non-Fatal Error

● Can the error be reproduced?
● Does it happen in both Basic and Standard?
● Analyze logs for error messages
● client_clock may assist
● Live console logs may assist
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Non-Fatal Error (continued)

● In error messages, look for design element 
names like view names or file names

● Use those design element names when 
searching ISA or Google
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Slow Performance

● Can the slow performance be reproduced?
● Does it happen in both Basic and Standard?
● client_clock can assist in tracking down the 

performance issue
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Slow Performance (continued)

● Biggest ‘Eclipse’ slowdown Issue has been 
on startup

● Cleaning/deleting the workspace folder 
usually fixes the issue
– Gets the user running, but doesn't determine root 

cause
– May not be the best thing to do in every case
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Slow Performance (continued)

● Start with our Eclipse console to see what is 
getting hung up
– Is there a particular file we are getting stuck on? 

Can we back it up, remove, see if Notes Starts?
– Search for known issues on that file

● If the Notes plug-in hasn’t loaded, it is 
possible the client_clock will not display 
anything

● Goal to fix on a file by file basis, not to 
delete entire directory
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Startup Slowdown Questions

● Is this the first start after an OS boot?
– “Cold-Start” vs “Warm Start”
– Many of the files may be cached for “Warm-Start”
– What is taking a long time to load?

● Usually the splash screen with status bar
● Verify this is the case

– Is the OS finished loading before starting Notes?
– What page will load when in

● Welcome page with databases open?
● Are these files local or remote?
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Slow Performance on Startup

● Disk fragmentation ?
● Disk free-space (20%) ?
● Disk Encryption on Notes Program and Data 

Directories ?
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General Troubleshooting Steps

● Close Notes Client
– Close all processes which may tie to the notes 

executables, such as PDA synchronization apps
– Ensure all processes are killed

● ‘Clean’ old log files, NSDs, ISA jar files etc
● Add appropriate debug
● Open Client
● Reproduce Issue
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General Troubleshooting Steps

● (continued from previous slide)
● Use ISA agent (optional) to gather logs
● Close Client (if applicable)

– Allow any NSDs to complete, or run manually
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Purpose Of Previous Slides

● Overall goal from previous slide is to create 
output only relevant to the current issue (go 
in, reproduce issue, go out)
– Attempt to reproduce issue on basic client
– Attempt to reproduce / fix issue
– Look through logs and console output
– Search Help Documentation
– Search Technotes / Other Resources
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Clean Old Logs and Files

● Move existing log files to non-Notes 
directory
– (Optional) Can be deleted if older, however not 

recommended to delete anything
● Can use debug_outfile and logfile_dir to 

redirect new logs to a different location
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Clean Old Logs/Files (continued)
● Clean up any old jar files from ISA, old 

NSDs etc. so we are only looking at an 
authentication, open the file with the issue, 
only see debug/traces for this issue
– They can be migrated to a non-Notes directory, 

backed up or removed
– Minimizing the amount of information will assist 

support in identifying the issue
● Too much info and log files from too long ago, may 

make it more difficult to troubleshoot the current issue
● Exception to this would be any install log (how the 

product was installed can be valuable)
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Adding Debug

● Make backup copies of the INI file and any 
other configuration files that may be edited

● Avoid adding unnecessary debug
– Only add what is applicable for the issue being 

analyzed, or what is requested by support
● Remember to remove debug when finished 

analyzing



Demo Time!
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Lab Time!

● We're going to do another demonstration
– Troubleshoot the error from the previous 

demonstration



References
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References

● Supported versions of Java with IBM Lotus 
Products
– http://www-01.ibm.com/support/docview.wss?

uid=swg21188789
● Notes 8 Preferences settings storage

– http://www-01.ibm.com/support/docview.wss?
uid=swg21283416
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References (continued)

● Troubleshooting Internet HTML e-mails with 
images appearing as red Xs
– http://www-01.ibm.com/support/docview.wss?

uid=swg21110585
● Internet Messages Arrive with Attachments 

or Body Parts That Appear Missing or Are 
Inaccessible
– http://www-01.ibm.com/support/docview.wss?

uid=swg21108466
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References (continued)

● Notes client does not render an attachment 
for users with 'No Preference'/'Keep in 
Sender's Format' as mail storage preference
– http://www-01.ibm.com/support/docview.wss?

uid=swg21109097
● IBM Support Assistant

– http://www-01.ibm.com/software/support/isa/
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